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Utiliser LibreOffice sur un Mac

Sur Mac, certaines touches et certains éléments de menu sont différents de ceux utilisés sous 
Windows ou Linux. Le tableau ci-dessous donne quelques substitutions courantes pour les instruc-
tions de ce chapitre. Pour une liste plus détaillée, voyez l’Aide de l’application.

Windows ou Linux Équivalent Mac Effet

Sélection du menu 
Outils > Options

LibreOffice > Préférences Accès aux options de configuration

Clic droit
Control+clic ou clic droit 
selon la configuration de l’ordinateur

Ouvre un menu contextuel

Ctrl (Control) ⌘ (Command) Utilisé avec d’autres touches

F5 Shift+⌘+F5 Ouvre le navigateur

F11 ⌘+T
Ouvre l’onglet Styles et Formatage 
du volet latéral

La documentation française de LibreOffice est disponible à
https://wiki.documentfoundation.org/Documentation/Publications/fr
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Introduction

Lorsque des textes sont utilisés dans des documents Draw, ils sont placés dans un objet ou un 
cadre de texte. Ce chapitre décrit comment créer, formater, utiliser et supprimer des textes. Il traite 
également des différents types de texte qui peuvent être insérés dans des dessins. Enfin, il indique
comment insérer certaines formes de texte particulières, comme des listes numérotées ou à puce, 
des tableaux, des champs, des hyperliens et des objets de Fontwork.

Le texte

Le mode texte

Avant de pouvoir saisir un texte dans un dessin, il faut activer le mode texte. Cliquez sur l’icône In-
sérer une zone de texte ( ) pour un texte horizontal ou Insérer un texte vertical ( ) pour un 
texte vertical dans la barre d’outils Standard (Figure 1) ou la barre d’outils Dessin (Figure 2). La 
barre d’outils Formatage du texte (Figure 3) s’ouvre automatiquement à la place de la barre d’outils
Ligne et remplissage.

Figure 1 : Les outils de texte dans la barre d’outils Standard

Figure 2 : Les outils de texte dans la barre d’outils Dessin

Figure 3 : La barre d’outils Formatage du texte

Si l’icône Insérer un texte vertical n’est pas visible dans la barre d’outils Standard ou Dessin, vous 
pouvez l’activer de la manière suivante :

 1) Sélectionnez Outils > Options dans la barre de menu et ouvrez la page Paramètres linguis-
tiques – Langues de la boîte de dialogue Options.

 2) Dans la section Langue par défaut des documents, cochez l’option Asiatique et choisissez
Par défaut – Chinois (simplifié) dans la liste déroulante.

 3) Cliquez sur Appliquer puis sur OK pour refermer la boîte de dialogue et enregistrer vos mo-
difications.

 4) Redémarrez LibreOffice pour activer le texte vertical.

Ajouter du texte

Quand vous ajoutez du texte à un dessin, un cadre de texte est automatiquement créé pour le 
contenir. Par défaut, ce cadre s’élargit horizontalement pour s’adapter à une ligne de texte unique. 
Pour changer le réglage par défaut, il faut formater le cadre de texte, voir « Formater les cadres 
de texte », page 7 pour plus d’informations.

Quand vous ajoutez du texte à un dessin, un cadre de texte est automatiquement créé pour conte-
nir celui-ci. Par défaut, le cadre de texte s’allonge horizontalement pour s’adapter à une ligne de 
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texte unique. Pour modifier ce comportement par défaut, il faut formater le cadre de texte, voyez 
« Formater les cadres de texte », page 7, pour plus d’informations.

 1) Activez le mode texte, voir « Le mode texte » ci-dessus pour plus d’informations.

 2) Cliquez dans votre dessin à l’emplacement approximatif où vous voulez placer le texte. Un 
cadre de texte qui contient un curseur clignotant est créé.

 3) Commencez à saisir votre texte. Le cadre de texte s’allonge automatiquement à mesure que 
vous tapez pour contenir votre ligne de texte. De plus, le deuxième champ à gauche de la 
barre d’état indique que vous êtes en mode d’édition de texte ainsi que la position de votre 
curseur (Figure 4).

Figure 4 : Informations sur le texte dans la barre d’état

 4) Pour créer plusieurs lignes dans le cadre de texte, utilisez l’une des méthodes suivantes :

– Appuyez sur la touche Entrée pour créer un nouveau paragraphe d’une seule ligne à 
l’intérieur du cadre de texte dont la hauteur augmente pour s’adapter à la ligne supplé-
mentaire.

– Créez un cadre de texte avant de saisir le texte, voir « Créer des cadres de texte » ci-
dessous. Quand vous atteignez la limite horizontale du cadre, le texte est automatique-
ment renvoyé à la ligne suivante et la hauteur du cadre augmente pour l’accueillir.

 5) Quand vous avez saisi tout le texte, cliquez hors du cadre de texte pour quitter le mode 
texte. La barre d’outils Formatage du texte se ferme et est remplacée par la barre d’outils 
Ligne et remplissage.

 6) Pour formater ou déplacer ce cadre de texte, voyez « Manipuler les cadres de texte » ci-
dessous et le chapitre 3, Manipuler les objets et les points des objets, pour plus d’informa-
tions.

 7) Si nécessaire, mettez le texte en forme : sélectionnez-le et utilisez les divers outils de la 
barre d’outils Formatage du texte (Figure 3) ou des sections Caractère et Paragraphe de 
l’onglet Propriétés du volet latéral (Figure 5). Pour plus d’informations sur la mise en forme 
du texte, voir « Formater du texte », page 12.
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Figure 5 : Les sections Caractère et Paragraphe
de l’onglet Propriétés du volet latéral

Créer des cadres de texte

Il est recommandé de créer un cadre de texte avant de saisir le texte dans votre dessin. Cela vous 
donne l’occasion de placer, par exemple, une légende pour une forme, une note explicative, un 
titre … semblable à ceux qui sont utilisés dans les dessins techniques.

 1) Activez le mode texte : voir « Le mode texte », page 1.

 2) Cliquez et faites glisser la souris, sans relâcher le bouton, pour dessiner un cadre de texte 
dans le document et en définir la largeur. La hauteur augmentera au fur et à mesure de la 
saisie du texte.

 3) Relâchez le bouton de la souris quand le cadre a la largeur souhaitée. Le curseur de texte 
apparaît à l’intérieur et le cadre est matérialisé par une bordure qui dépend de votre système
d’exploitation et qui indique que vous êtes en mode édition de texte (Figure 4).

 4) Saisissez ou collez le texte dans le cadre. La barre d’état indique que vous êtes en mode 
Édition texte et la position du curseur dans le cadre (paragraphe, ligne, colonne), voir Figure 
4.

 5) Cliquez hors du cadre pour le désélectionner et quitter le mode texte. La barre d’outils For-
matage du texte se ferme et est remplacée par la barre d’outils Ligne et remplissage.

 6) Si nécessaire, mettez le texte en forme : sélectionnez-le et utilisez les divers outils de la 
barre d’outils Formatage du texte (Figure 3) ou des sections Caractère et Paragraphe de 
l’onglet Propriétés du volet latéral (Figure 5). Pour plus d’informations sur la mise en forme 
du texte, voir « Formater du texte », page 12.
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Remarque

Les cadres de texte utilisent un moteur d’édition simplifié et ne sont conçus que pour conte-
nir du texte. Ils ne peuvent pas recevoir d’illustrations, d’images en ligne, de formules, de ta-
bleaux ni de formes.

Manipuler les cadres de texte

Vous pouvez formater, déplacer, faire pivoter un cadre de texte et en modifier la taille exactement 
comme n’importe quel objet de votre dessin. Pour plus d’informations, voir le chapitre 3,  Manipu-
ler les objets et les points des objets.

Déplacer un cadre de texte

 1) Cliquez sur le texte dans le cadre pour passer en mode d’édition et faire apparaître la bor-
dure épaisse correspondant à ce mode.

 2) Placez le pointeur de la souris au-dessus de la bordure. Il prend la forme du pointeur de dé-
placement de votre ordinateur (par exemple une flèche à quatre branches).

Vous pouvez aussi cliquer juste à côté du cadre de texte (gauche, droite, haut, bas) où le 
pointeur de la souris est un pointeur de déplacement.

Le cadre de texte est sélectionné : les poignées de sélection apparaissent sur la bordure 
épaisse.

 3) Cliquez au-dessus de la bordure (mais pas sur une poignée de sélection) et faites glisser le 
cadre de texte jusqu’à sa nouvelle position. Une copie transparente du cadre vous permet de
voir à quel endroit vous allez le déplacer (Figure 6). Vous pouvez voir l’amplitude du déplace-
ment dans la barre d’état.

Figure 6 : Déplacer un cadre de texte

 4) Relâchez le bouton de la souris quand le cadre de texte est dans la position voulue.

 5) Pour positionner un cadre de texte avec précision, utilisez la boîte de dialogue Position et 
taille ou la section Position et taille de l’onglet Propriétés du volet latéral. Voir le chapitre 3, 
Manipuler les objets et les points des objets, pour plus d’informations sur cette boîte de dia-
logue et cette section du volet latéral.
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Redimensionner un cadre de texte

 1) Cliquez sur le texte dans le cadre pour passer en mode d’édition et faire apparaître la bor-
dure épaisse correspondant à ce mode.

 2) Placez le pointeur de la souris au-dessus de la bordure. Il prend la forme du pointeur de dé-
placement de votre ordinateur (par exemple une flèche à quatre branches).

Vous pouvez aussi cliquer juste à côté du cadre de texte (gauche, droite, haut, bas) où le 
pointeur de la souris est un pointeur de déplacement.

Le cadre de texte est sélectionné : les poignées de sélection apparaissent sur la bordure 
épaisse.

 3) Déplacez le pointeur de la souris au-dessus d’une poignée de sélection. Il change de forme 
et devient le symbole de redimensionnement d’objet qui dépend de votre ordinateur (par 
exemple une flèche à deux extrémités).

 4) Cliquez et faites glisser la poignée de sélection pour redimensionner le cadre de texte. Une 
copie transparente du cadre vous permet de voir son nouvel aspect (Figure 7).

Figure 7 : Modifier les dimensions d’un cadre de texte.

 5) Relâchez le bouton de la souris quand le cadre atteint la taille voulue.

 6) Pour donner une dimension précise à un cadre de texte, utilisez la boîte de dialogue Position
et taille ou la section Position et taille de l’onglet Propriétés du volet latéral. Voir le chapitre 
3, Manipuler les objets et les points des objets, pour plus d’informations sur cette boîte de 
dialogue et cette section du volet latéral.

Pour conserver les proportions d’un cadre de texte lors de son redimensionnement, maintenez la 
touche Maj enfoncée avant de cliquer-glisser. Prenez soin de relâcher le bouton de la souris avant
la touche Maj.

Remarque

Par défaut, vous ne pouvez réduire la hauteur d’un cadre de texte en dessous de la hauteur 
minimale pour que le texte entier apparaisse. Pour cette raison, il est possible que, si vous 
réduisez la largeur du cadre, sa hauteur augmente. Voir l’option Adapter la hauteur au texte 
de la boîte de dialogue Position et taille.
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Faire pivoter un cadre de texte

 1) Cliquez sur le texte dans le cadre pour passer en mode d’édition et faire apparaître la
bordure épaisse correspondant à ce mode.

 2) Placez le pointeur de la souris au-dessus de la bordure. Il prend la forme du pointeur de dé-
placement de votre ordinateur (par exemple une flèche à quatre branches).

Vous pouvez aussi cliquer juste à côté du cadre de texte (gauche, droite, haut, bas) où le 
pointeur de la souris est un pointeur de déplacement.

Le cadre de texte est sélectionné : les poignées de sélection apparaissent sur la bordure 
épaisse.

 3) Cliquez de nouveau sur la bordure du cadre, cliquez sur l’icône Pivoter ( ) dans la barre 
d’outils Transformations ou sélectionnez Forme > Transformations > Pivoter dans la barre 
de menu. Les poignées de sélection changent de forme et de couleur.

 4) Cliquez sur une des poignées de coin et faites-la glisser pour faire tourner le cadre de texte. 
Une copie transparente du cadre vous permet de voir sa nouvelle orientation et l’angle de ro-
tation est affiché dans la barre d’état (Figure 8).

Figure 8 : Faire pivoter un cadre de texte

 5) Relâchez le bouton de la souris quand le cadre atteint l’orientation voulue.

 6) Pour faire tourner un cadre de texte avec précision, utilisez l’onglet Rotation de la boîte de 
dialogue Position et taille ou la section Position et taille de l’onglet Propriétés du volet laté-
ral. Voir le chapitre 3, Manipuler les objets et les points des objets, pour plus d’informations 
sur cette boîte de dialogue et cette section du volet latéral.
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Remarque

En mode rotation, les poignées des milieux des côtés, bien que visibles, ne peuvent pas être
utilisées. De plus, les cadres de texte ne peuvent être ni déformés, ni inclinés, ni retournés 
verticalement ou horizontalement.

Formater les cadres de texte

Les cadres de texte peuvent être formatés comme les autres formes de base de votre dessin 
quand il s’agit d’en définir le remplissage et la bordure (ligne). Voir le chapitre 3, Manipuler les ob-
jets et les points des objets, pour plus d’informations sur le formatage des cadres de texte.

Pour définir la façon dont le texte se présente dans un cadre de texte, procédez comme ceci :

 1) Sélectionnez le cadre de texte et utilisez une des méthodes suivantes pour ouvrir la boîte de 
dialogue Texte :

– faites un clic droit sur le cadre de texte et choisissez Texte… dans le menu contextuel ;

– sélectionnez Format > Texte… dans la barre de menu.

Remarque

Faites bien attention de sélectionner l’entrée Texte… dans le menu Format et pas l’entrée 
Texte ► car celle-ci ouvre un sous-menu qui vous permet de formater le texte et non le 
cadre de texte lui-même.

 2) Dans l’onglet Texte (Figure 9), choisissez les options voulues dans les sections Texte d’ob-
jet de dessin et Espacement avec les bordures.

Figure 9 : La boîte de dialogue Texte

 3) Dans l’onglet Animation de texte (Figure 10), choisissez les options voulues dans les sec-
tions Effet et Propriétés. Cela est, toutefois, déconseillé sauf si votre dessin est conçu pour 
être affiché dans une présentation. Voyez le Guide Impress pour plus d’informations sur l’ani-
mation du texte.
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Figure 10 : L’onglet Animation de texte de la boîte de dialogue Texte

 4) Cliquez sur OK pour enregistrer les options choisies et refermer la boîte de dialogue.

Supprimer un cadre de texte

Pour supprimer un cadre de texte, sélectionnez-le, puis appuyez sur la touche Suppr.

Associer des textes à des objets Draw

Il est possible d’associer un texte à la plupart des objets Draw. Les exceptions sont les éléments 
de contrôle, comme les boutons ou les listes déroulantes, les polygones, les courbes et les sé-
quences 3D.

Par défaut, un objet n’est pas dynamique quand il est créé et ne se comporte pas comme un cadre
de texte. Le renvoi à la ligne n’est pas automatique et pour conserver un texte à l’intérieur des bor-
dures d’un objet, vous devrez créer des paragraphes (touche Entrée), des sauts de ligne 
(touches Maj+Entrée), réduire la taille de la police ou agrandir l’objet, ou combiner ces quatre 
possibilités.

Pour associer un texte à un objet avec un renvoi à la ligne automatique à l’intérieur de celui-ci :

 1) Créez un objet dans votre dessin et assurez-vous qu’il est sélectionné et que les poignées 
de sélection sont visibles.

 2) Cliquez sur l’icône Insérer une zone de texte ( ) pour un texte horizontal ou Insérer un 
texte vertical ( ) pour un texte vertical dans la barre d’outils Standard (Figure 1, page 1) 
ou la barre d’outils Dessin (Figure 2, page 1). Un curseur de texte se met à clignoter au 
centre de l’objet et la barre d’outils Formatage du texte (Figure 3, page 1) s’ouvre automati-
quement à la place de la barre d’outils Ligne et remplissage. Vous pouvez alors saisir votre 
texte.

Vous pouvez également faire un double-clic sur l’objet pour faire apparaître le curseur de 
texte au centre et entrer automatiquement en mode d’édition de texte horizontal.

Dans ce cas, pour passer en texte vertical, cliquez sur l’icône Insérer un texte vertical ( ) 
pour un texte vertical dans la barre d’outils Standard ou la barre d’outils Dessin.
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 3) Commencez à saisir votre texte. S’il dépasse les bordures de l’objet, utilisez les paragraphes
(Entrée), les changements de ligne (Maj+Entrée), la réduction de la taille de la police ou 
l’agrandissement de l’objet, ou une combinaison de ces quatre possibilités.

LibreOffice Draw Version 6.4

LibreOffice 
Draw 

Version 
6.4

Par défaut, sans
renvoi à la ligne

Avec renvoi à la
ligne dans la forme

Figure 11 : Exemple de renvoi à la ligne dans un objet

Pour être certain que votre texte reste à l’intérieur de la bordure de l’objet (Figure 11), vous 
pouvez aussi procéder de la manière suivante :

 a) Faites un clic droit sur le texte à l’intérieur de l’objet et choisissez Texte… dans le menu 
contextuel pour ouvrir la boîte de dialogue Texte (Figure 12)

Figure 12 : La boîte de dialogue Texte, avec l’option
Renvoyer le texte à la ligne dans la forme sélectionnée

 b) Ouvrez l’onglet Texte.

 c) Dans la section Texte de forme personnalisée, cochez l’option Renvoyer le texte à la 
ligne dans la forme.

 d) Cliquez sur OK pour refermer la boîte de dialogue et enregistrer votre choix.

 e) Finissez de saisir le texte, cliquez hors de l’objet pour quitter le mode texte et enregistrer 
vos modifications. Le texte est ajusté au mieux à l’intérieur de l’objet par des retours auto-
matiques à la ligne comme sur la droite de la Figure 11.
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 4) Pour formater le texte à l’intérieur de l’objet, voir « Formater du texte », page 12.

Remarque

Si le double-clic n’active pas le mode d’édition de texte, sélectionnez Affichage > Barres 
d’outils > Options dans la barre de menu pour ouvrir la barre d’outils Options et cliquez sur
l’icône Double-clic pour éditer du texte ( ) ou appuyez sur la touche F2.

Insérer du texte

Coller du texte

Un texte peut être inséré dans un cadre de texte ou dans un objet en le copiant depuis un autre 
document et en le collant dans le cadre ou l’objet de votre dessin.

Quand vous collez le texte 

• avec l’icône Coller ( ) de la barre d’outils Standard,

• l’entrée Coller du menu Édition ou du menu contextuel ouvert par un clic droit

• par l’appui sur la combinaison Ctrl+V,

Le texte est inséré avec son formatage d’origine qui peut ne pas correspondre au format des 
textes déjà inclus dans votre dessin. Cela peut parfois être ce que vous désirez, mais, le plus sou-
vent, il vaut mieux assurer l’homogénéité du formatage du texte dans tout le dessin.

Remarque

Si vous collez du texte directement dans un dessin, et non dans un objet ou un cadre, il est 
inséré en tant qu’objet OLE et non d’objet Draw. Il est recommandé de coller le texte dans 
Draw sous forme de texte non formaté pour créer un objet texte de Draw.

Coller du texte non formaté

C’est une bonne habitude de coller le texte sans formatage puis d’appliquer celui-ci après en cohé-
rence avec le texte déjà inséré dans votre dessin.

Pour coller un texte avec le format par défaut du paragraphe de destination,

 1) Copier le texte dans son document d’origine puis activez la fenêtre de votre dessin.

 2) Collez le texte que vous venez de copier par une des méthodes suivantes :

– cliquez sur le petit triangle à droite de l’icône Coller de la barre d’outils Standard et choi-
sissez Texte non formaté dans la liste,

– sélectionnez Édition > Collage spécial > Coller le texte non formaté dans la barre de 
menu

– sélectionnez Édition > Collage spécial > Collage spécial dans la barre de menu ou ap-
puyez sur les touches Ctrl+Maj+V et choisissez Texte non formaté dans la boîte de dia-
logue Collage spécial qui s’ouvre (Figure 13).
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Figure 13 : la boîte de dialogue Collage spécial

 3) Un cadre contenant le texte avec le style de formatage par défaut est collé dans le dessin, 
au milieu de l’espace de travail.

Coller du texte PDF

Le texte provenant d’un document PDF est collé dans un cadre de texte au centre de l’espace de 
travail ou à l’intérieur d’un objet si le mode texte est activé (curseur clignotant dans l’objet)

 1) Sélectionnez le texte que vous voulez coller dans le fichier PDF et copiez-le dans le Presse-
papier.

 2) Activez la fenêtre de votre dessin et collez le texte par l’une des méthodes suivantes. Il peut 
conserver (selon le lecteur de fichier PDF utilisé) une partie de son formatage.

– Cliquez sur l’icône Coller ( ) de la barre d’outils Standard.

– Sélectionnez Édition > Coller dans la barre de menu.

– Appuyez sur les touches Ctrl+V.

– Faites un clic droit dans le dessin et choisissez Coller dans le menu contextuel.

Éventuellement, voyez « Coller du texte non formaté » ci-dessus si vous désirez coller le 
texte non formaté dans votre dessin.

Formater le texte collé

 1) Sélectionnez le texte que vous venez de coller (voir « Sélectionner du texte » ci-dessous 
pour plus d’informations). La barre d’outils Formatage du texte (Figure 1, page 1) s’ouvre au-
tomatiquement à la place de la barre d’outils Ligne et remplissage.

 2) Utilisez les outils de formatage disponibles dans

– la barre d’outils Formatage du texte,

– les sections Caractère et Paragraphe de l’onglet Propriétés du volet latéral,

– le menu Format.

 3) Vous pouvez utiliser un des choix possibles dans l’onglet Styles du volet latéral. Voir « Utili-
ser les styles de dessin », page 18, pour plus d’informations.
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Insérer des caractères spéciaux, espaces insécables et tirets

Pour toute information sur l’insertion de caractères spéciaux, d’espaces insécables et de tirets 
dans un dessin, voyez le Guide du débutant et le Guide Writer.

Formater du texte

L’utilisation judicieuse du formatage peut donner aux textes de votre dessin un aspect plus homo-
gène et professionnel, sans éléments de différenciation pouvant distraire l’attention. Le formatage 
du texte peut demander d’intervenir sur les attributs des caractères (par exemple, la couleur de po-
lice), des paragraphes (par exemple, l’alignement) ou des listes (par exemple, le type de puces).

Sélectionner du texte

Avant tout formatage d’un texte, celui-ci doit être sélectionné dans le cadre ou l’objet qui le 
contient :

 1) Assurez-vous que le cadre ou l’objet contenant le texte que vous voulez sélectionner est lui-
même sélectionné.

 2) Cliquez à l’intérieur du texte pour positionner le curseur.

 3) Sélectionnez le texte à formater grâce l’une des méthodes suivantes :

– appuyez sur Ctrl+A pour sélectionner tout le texte ;

– cliquez et tirez le pointeur de la souris sur le texte à sélectionner ;

– appuyez sur Maj et les touches de direction pour étendre votre sélection caractère par ca-
ractère (droite et gauche) ou ligne par ligne (haut et bas) ;

– appuyez sur Maj+Ctrl et les touches de direction droite et gauche pour étendre votre 
sélection mot par mot ;

– appuyez sur Maj+Début pour étendre votre sélection jusqu’au début de la ligne ;

– appuyez sur Maj+Fin pour étendre votre sélection jusqu’à la fin de la ligne.

 4) Effectuez alors le formatage.

Formatage direct du texte

Dans LibreOffice Draw, le formatage effectué sur le texte est normalement un formatage direct. 
Cependant, dans les situations où vous devez réaliser le même formatage sur plusieurs para-
graphes de texte, l’utilisation des styles de paragraphe est recommandée.

Conseil

Il est parfois très utile de réappliquer le format par défaut du texte sélectionné et ainsi de 
supprimer tout formatage manuel effectué, particulièrement si vous avez fait une erreur et 
n’êtes pas sûr de la façon de l’annuler. Pour revenir au style par défaut, sélectionnez la por-
tion de texte concernée et sélectionnez Effacer le formatage direct dans le menu Format 
ou dans le menu contextuel ouvert par un clic droit sur le texte sélectionné, ou appuyez sur 
Ctrl+M.
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Formatage direct des caractères

Les caractères d’un texte peuvent être formatés indépendamment du formatage utilisé pour le pa-
ragraphe. Ce formatage vient écraser le formatage du paragraphe appliqué directement ou par un 
style de paragraphe. Notez qu’il n’existe pas de style de caractère dans Draw. Tout formatage de 
caractère doit être appliqué directement.

Remarque

Si un cadre de texte ou un objet est sélectionné, mais pas le texte qu’il contient, tout forma-
tage de caractère s’appliquera à l’ensemble de ce texte.

 1) Cliquez dans le texte où vous voulez formater des caractères. La barre d’outils Formatage 
du texte (Figure 1, page 1) s’ouvre automatiquement à la place de la barre d’outils Ligne et 
remplissage.

 2) Sélectionnez les caractères que vous souhaitez formater. Voir « Sélectionner du texte » ci-
dessus pour plus d’informations sur la façon de procéder.

 3) Utilisez une des méthodes suivantes pour ouvrir la boîte de dialogue Caractère (Figure 14 et
Figure 15) : sélectionnez Format > Caractère dans la barre de menu ou faites un clic droit 
sur les caractères sélectionnés et choisissez Caractère dans le menu contextuel.

Figure 14 : La boîte de dialogue Caractère quand
les polices de texte asiatique et de scripts complexes sont activées
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Figure 15 : La boîte de dialogue Caractère quand
les polices de texte asiatique et de scripts complexes ne sont pas activées.

 4) Effectuez les modifications désirées dans le formatage des caractères en utilisant les options
disponibles dans les onglets de la boîte de dialogue Caractère.

 5) Cliquez sur OK pour enregistrer ces modifications et refermer la boîte de dialogue.

Au lieu de la boîte de dialogue Caractères, vous pouvez utiliser les outils proposés par la barre 
d’outils Formatage du texte (Figure 1, page 1), par la section Caractère de l’onglet Propriétés du 
volet latéral ou par le menu Format > Texte.

Pour annuler les changements que vous avez apportés au formatage des caractères, cliquez sur 
le bouton Réinitialiser dans la boîte de dialogue Caractère (avant d’appuyer sur OK) ou sélection-
nez Format > Effacer le formatage direct dans la barre de menu (après avoir refermé la boîte de
dialogue) pour que les caractères reprennent le formatage appliqué au paragraphe.

Options de la boîte de dialogue Caractère

Les onglets de la boîte de dialogue Caractère proposent les options suivantes :

Police
Vous pouvez y choisir le type de police, ses attributs de base (Italique, Gras, Langue, etc.) 
ainsi que sa taille. Un exemple de la police est affiché en bas de la boîte de dialogue. Cet on-
glet est aussi disponible pour créer ou modifier un style de dessin.

Si le support des langues asiatiques et de la mise en page de texte complexe a été activé 
(Outils > Options, page Paramètres linguistiques – Langues), la page Police offre trois sec-
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tions pour les polices de texte occidental, asiatique et les scripts complexes où vous pouvez 
spécifier les polices et leurs attributs pour la majorité des familles de polices.

Effets de caractère
Vous pouvez appliquer ici des effets spéciaux au texte (sections Couleur de la police, Dé-
coration du texte et Effets). Un exemple de texte est affiché en bas de la boîte de dialogue 
pour vous permettre de juger rapidement de l’effet appliqué. Cet onglet est aussi disponible 
pour créer ou modifier un style de dessin.

Position
Choisissez ici le type de position, d’échelle et d’espacement appliqué aux caractères. Cet 
onglet n’est pas disponible pour créer ou modifier un style de dessin.

– Position vous permet de définir la position des caractères par rapport à la ligne de base 
quand vous insérez des exposants ou des indices.

– Échelle de largeur définit le pourcentage de la largeur de la police par lequel les carac-
tères sélectionnés seront comprimés ou étirés.

– Espacement des caractères définit l’espace entre les caractères en nombre de points.

– Paire de crénage : cochez cette option pour ajuster automatiquement l’espace entre cer-
taines paires de caractères et améliorer leur apparence visuelle.

Surlignage1

Définissez ici une couleur de fond propre aux caractères sélectionnés (comme si on avait uti-
lisé un surligneur).

Formatage direct des paragraphes

Chaque paragraphe du texte peut être formaté indépendamment. Ce formatage vient écraser celui
du style d’image utilisé.

 1) Cliquez dans le texte où vous voulez formater des caractères. La barre d’outils Formatage 
du texte (Figure 1, page 1) s’ouvre automatiquement à la place de la barre d’outils Ligne et 
remplissage.

 2) Sélectionnez les paragraphes que vous souhaitez formater. Voir « Sélectionner du texte » 
page 12 pour plus d’informations sur la façon de procéder.

 3) Utilisez une des méthodes suivantes pour ouvrir la boîte de dialogue Paragraphe (Figure 
16) :

– sélectionnez Format > Paragraphe dans la barre de menu ;

– faites un clic droit sur le texte sélectionné et choisissez Paragraphe dans le menu contex-
tuel ;

– cliquez sur l’icône Paragraphe dans la barre d’outils Formatage du texte.

 4) Effectuez les modifications désirées dans le formatage des paragraphes en utilisant les op-
tions disponibles dans les onglets de la boîte de dialogue Paragraphe.

 5) Cliquez sur OK pour enregistrer ces modifications et refermer la boîte de dialogue.

1 Ne pas confondre cette option avec l’option Surlignage de la section Décoration du texte dans l’onglet Effets de 
caractère qui concerne un trait dessiné au-dessus des caractères.
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Figure 16 : L’onglet Retraits et espacement de la boîte de dialogue Paragraphe

Au lieu de la boîte de dialogue Paragraphe, vous pouvez utiliser les outils proposés par la barre 
d’outils Formatage du texte (Figure 1, page 1), par la section Caractère de l’onglet Propriétés du 
volet latéral ou par les menus Format > Espacement et Format > Aligner.

Pour annuler les changements que vous avez apportés au formatage des caractères, cliquez sur 
le bouton Réinitialiser dans la boîte de dialogue Paragraphe (avant d’appuyer sur OK) ou sélec-
tionnez Format > Effacer le formatage direct dans la barre de menu (après avoir refermé la boîte
de dialogue) pour que les paragraphes reprennent le formatage appliqué précédemment.

Options de la boîte de dialogue Paragraphe

Les onglets de la boîte de dialogue Paragraphe proposent les options suivantes :

Retraits et espacement
Cet onglet (Figure 16) détermine les retraits et espacements appliqués aux paragraphes sé-
lectionnés :

– Retrait : définissez ici les retraits avant et après le texte ainsi que le retrait particulier de la
première ligne du paragraphe.

– Espacement : indiquez ici l’espace au-dessus et en dessous des paragraphes sélection-
nés.

– Interligne : ce choix détermine l’espace entre deux lignes d’un même paragraphe. Si vous 
choisissez Proportionnel, vous devez préciser l’interligne en pourcentage de la hauteur de
la ligne elle-même : 100 % pour une ligne, 200 % pour deux lignes, 50 % pour la moitié de
la ligne. Si vous choisissez Fixe, indiquez la valeur de l’interligne dans l’unité de mesure 
par défaut.
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Remarque

Vous pouvez changer l’unité de mesure par défaut en sélectionnant Outils > Options dans 
la barre de menu puis en ouvrant la page LibreOffice Draw – Général dans la boîte de dia-
logue Options.

Typographie asiatique
Vous pouvez définir ici certains paramètres reliés à la typographie des langues asiatiques. 
Cet onglet n’apparaît que si l’option Asiatique est cochée dans la page Paramètres linguis-
tiques – Langues de la boîte de dialogue Options (Outils > Options).

Figure 17 : L’onglet Typographie asiatique de la boîte de dialogue Paragraphe

Tabulation
Définissez ici la position, le type et le caractère de remplissage des arrêts de tabulation. Cet 
onglet est aussi disponible pour créer ou modifier un style de dessin.

Figure 18 : L’onglet Tabulations de la boîte de dialogue Paragraphe.

Alignement
Cet onglet (Figure 19) détermine l’alignement du paragraphe. Une zone d’aperçu (à droite) 
montre l’effet des modifications effectuées. L’alignement d’un paragraphe peut aussi être dé-
fini grâce aux icônes ( , ,  et ) de la barre d’outils Formatage du texte et de la sec-
tion Paragraphe de l’onglet Propriétés du volet latéral.

– Options  : choisissez l’alignement du paragraphe.

– Texte-à-texte : définissez l’alignement vertical du texte quand il y a un mélange de tailles 
de police sur la même ligne de texte. Vous avez le choix entre Automatique, Ligne de 
base, Haut, Milieu et Bas.

– Propriétés : sélectionnez la direction du texte. De-gauche-à-droite et De-droite-à-gauche 
ne sont disponibles que si l’option Mise en page de texte complexe a été sélectionnée 
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dans la page Paramètres linguistiques – Langues de la boîte de dialogue Options (Outils 
> Options).

Figure 19 : L’onglet Alignement de la boîte de dialogue Paragraphe

Utiliser les styles de dessin

Appliquer les mêmes options de formatage à des objets ou des textes de Draw est un processus 
répétitif qui peut être grandement simplifié par l’utilisation de styles. Les styles de dessin dans 
Draw vous permettent de définir un modèle de formatage (un style) puis de l’appliquer à plusieurs 
objets graphiques ou textuels.

Pour plus d’informations sur les paramètres purement graphiques des styles de dessin, comme le 
remplissage et les lignes, voir le chapitre 4, Modifier les attributs d’un objet, de ce guide. Pour plus 
d’informations sur les styles de texte, voir le Guide Writer.

Figure 20 : L’onglet Gestionnaire de la boîte de dialogue Styles pour objets graphiques

Draw offre plusieurs styles prêts à l’emploi avec des objets ou des textes. Ces styles prédéfinis ne 
peuvent être ni supprimés ni renommés, mais on peut les modifier grâce aux options de la boîte de
dialogue Styles pour objets graphiques (Figure 20).
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Styles liés

Dans Draw, un style peut hériter des paramètres de formatage d’un autre style auquel il est lié. 
Cette propriété permet de créer des familles de styles hiérarchisés. La Figure 21 montre un 
exemple de hiérarchies de styles liés utilisés dans Draw.

Figure 21 : L’onglet Styles dans le volet latéral

Par exemple, si vous avez plusieurs cadres de texte qui ne diffèrent que par la taille de la police, 
mais qui ont, par ailleurs, un formatage identique, il est recommandé de créer un style de base 
pour le type et le style de police et les autres paramètres de formatage. Créez ensuite tous les 
styles nécessaires qui en dépendent hiérarchiquement et ne diffèrent que par la taille de la police. 
S’il devient nécessaire de modifier le style de la police, il suffira de le faire dans le style parent pour
modifier en conséquence tous les styles qui lui sont liés.

Remarque

Quand des styles sont liés, modifier un attribut de la police dans le style parent changera ce-
lui-ci chez tous ses descendants. C’est parfois exactement ce que vous souhaitez, parfois 
non. Il vaut la peine d’y réfléchir avant.
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Créer de nouveaux styles

Quand un nouveau style est créé, il est placé dans les listes Tous les styles et Styles personnali-
sés de l’onglet Styles du volet latéral (en bas de la Figure 21). Quand il aura été appliqué à un ob-
jet ou à un texte, il apparaîtra aussi dans la liste Styles appliqués.

 1) Apportez toutes les modifications souhaitées au texte sélectionné puis

– faites un clic droit sur le nom d’un style dans le volet latéral et sélectionnez Nouveau 
dans le menu contextuel, pour ouvrir la boîte de dialogue Styles pour objets graphiques 
(Figure 20, page 18),

– cliquez sur l’icône Nouveau style à partir de la sélection dans le volet latéral (encadrée 
sur la Figure 21), et saisissez un nom unique pour le nouveau style dans la boîte de dia-
logue Nom du style qui s’ouvre et cliquez sur OK pour la refermer et enregistrer vos modi-
fications.

 2) Si vous utilisez la boîte de dialogue Styles pour objets graphiques, procédez comme ceci :

 a) Ouvrez l’onglet Gestionnaire (Figure 20, page 18).

 b) Saisissez un nom unique pour votre style dans le champ Nom.

 c) Si vous ne souhaitez pas lier le nouveau style à un autre, sélectionnez – Aucun(e) – dans 
le champ Hérité de, sinon sélectionnez le nom du style parent dans la liste déroulante.

 d) Cliquez sur OK pour enregistrer vos modifications et refermer la boîte de dialogue.

Modifier ou éditer les styles

Il est recommandé de modifier seulement les styles que vous avez créés.

 1) Sélectionnez un texte ou un objet contenant du texte dans votre dessin. La barre d’outils 
Formatage du texte (Figure 1, page 1) s’ouvre automatiquement à la place de la barre d’ou-
tils Ligne et remplissage.

 2) Ouvrez la boîte de dialogue Styles pour objets graphiques (Figure 20, page 18) grâce à une 
des méthodes suivantes :

– sélectionnez Format > Styles > Éditer le style dans la barre de menu,

– faites un clic droit sur l’objet et sélectionnez Éditer le style dans le menu contextuel,

– faites un clic droit sur le style de l’objet dans l’onglet Styles du volet latéral et sélectionnez
Modifier dans le menu contextuel.

 3) Utilisez les options des divers onglets de la boîte de dialogue Styles pour objets graphiques 
pour modifier le style de la manière suivante :

– l’onglet Gestionnaire affiche le nom du style, le nom de celui dont il a hérité le formatage, 
sa catégorie et les paramètres de son formatage ;

– les onglets Police, Effets de caractère, Retraits et espacement, Alignement et Tabulations 
définissent les propriétés du texte inséré dans un cadre ou un objet graphique ;

– l’onglet Cotation permet de paramétrer le style des lignes de cote ;

– les onglets Texte, Animation de texte, Connecteur, Ligne, Remplissage, Ombrage, Mise 
en évidence et Transparence déterminent le formatage de l’objet.
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 4) Cliquez sur OK quand vous avez terminé pour enregistrer vos modifications et refermer la 
boîte de dialogue Styles pour objets graphiques.

Vous pouvez aussi sélectionner votre texte et lui appliquer toutes les modifications de formatage 
puis procéder de la manière suivante :

 1) Sélectionner un style dans l’onglet Styles du volet latéral (Figure 21, page 19).

 2) Cliquez sur l’icône Actualiser le style ( ) en haut du volet latéral pour enregistrer le style 
avec les nouveaux attributs de formatage.

Éditer des styles liés

Si un objet de votre document utilise des styles liés, il est possible d’éditer les styles liés qui lui ont 
été appliqués en utilisant la boîte de dialogue Styles pour objets graphiques de la façon suivante :

 1) Sélectionnez un texte ou un objet contenant du texte dans votre dessin qui utilise les styles 
liés. La barre d’outils Formatage du texte (Figure 1, page 1) s’ouvre automatiquement à la 
place de la barre d’outils Ligne et remplissage.

 2) Ouvrez la boîte de dialogue Styles pour objets graphiques (Figure 20, page 18) grâce à une 
des méthodes suivantes :

– sélectionnez Format > Styles > Éditer le style dans la barre de menu,

– faites un clic droit sur l’objet et sélectionnez Éditer le style dans le menu contextuel,

– faites un clic droit sur le style de l’objet dans l’onglet Styles du volet latéral et sélectionnez
Modifier dans le menu contextuel.

 3) Ouvrez l’onglet Gestionnaire (Figure 20, page 18).

 4) Cliquez sur le bouton Éditer le style à droite du champ Hérité de jusqu’à ce que le nom du 
style dans le titre de la boîte de dialogue Style pour objets graphiques soit celui que vous 
voulez modifier.

Utilisez alors les divers onglets de la boîte de dialogue Styles pour objets graphiques pour 
modifier ce style.

 5) Cliquez sur OK quand vous avez terminé pour enregistrer vos modifications et refermer la 
boîte de dialogue Styles pour objets graphiques.

Appliquer des styles

Vous pouvez appliquer un style au texte dans un cadre de texte ou un objet de la façon suivante :

 1) Sélectionnez le texte auquel vous voulez appliquer un style. La barre d’outils Formatage du 
texte (Figure 1, page 1) s’ouvre automatiquement à la place de la barre d’outils Ligne et rem-
plissage.

 2) Ouvrez l’onglet Styles du volet latéral en cliquant sur son icône .

 3) Faites un double-clic sur le nom du style désiré dans l’onglet Styles (Figure 21, page 19) 
pour appliquer le style à l’objet sélectionné.
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Conseil

Une liste de déroulante située en bas de l’onglet Styles du volet latéral vous permet de limi-
ter les styles affichés. Choisissez d’afficher Tous les styles, les Styles personnalisés ou les 
Styles appliqués selon vos besoins.

Supprimer des styles

Vous ne pouvez pas supprimer les styles prédéfinis de LibreOffice, même si vous ne les utilisez 
pas. Vous ne pouvez supprimer que les styles que vous (ou un autre utilisateur) a définis. Cepen-
dant, avant de supprimer un style créé par vous, assurez-vous qu’il n’est pas en cours d’utilisation.
Pour cela, choisissez Styles appliqués dans la liste déroulante en bas de l’onglet Styles du volet la-
téral.

Il n’est pas possible de supprimer les styles prédéfinis dans LibreOffice, même si vous ne les utili-
sez pas. Vous ne pouvez supprimer que les styles que vous (ou un autre utilisateur) avez définis. 
Avant de supprimer un style personnalisé, assurez-vous cependant qu’il n’est pas utilisé. Pour voir 
les styles utilisés, choisissez Styles appliqués dans la liste déroulante

Supprimez un style personnalisé comme ceci :

 1) Ouvrez l’onglet Styles du volet latéral en cliquant sur son icône  (Figure 21, page 19).

 2) Choisissez Styles personnalisés ou Styles appliqués dans la liste déroulante en bas de l’on-
glet Styles du volet latéral pour afficher les styles utilisés.

 3) Faites un clic droit sur le nom d’un style dans la liste et sélectionnez Effacer dans le menu 
contextuel.

 4) Si le style est utilisé, un message d’avertissement apparaît. Cliquez sur Oui pour supprimer 
le style. Si le style n’est pas utilisé, la suppression est immédiate sans message d’avertisse-
ment.

Créer des listes à puces et numérotées

Les listes à puces et numérotées peuvent être créées dans des cadres de textes, les formes et 
dans des objets. Cependant, si vous créez une liste dans un objet, gardez à l’esprit que cet objet 
n’est pas dynamique et ne va pas s’étendre au fur et à mesure de la création de la liste.

Remarque

La création de listes à puces ou numérotées dans Draw se fait de la même façon que dans 
LibreOffice Writer, mais leurs fonctionnalités dans Draw sont réduites.

Créer des listes

Vous pouvez créer des listes à puces ou numérotées dans les cadres de texte ou les objets de 
Draw de la façon suivante :

 1) Cliquez dans le texte où vous voulez créer une liste. La barre d’outils Formatage du texte (Fi-
gure 1, page 1) s’ouvre automatiquement à la place de la barre d’outils Ligne et remplissage.

 2) Sélectionnez tout le texte que vous voulez utiliser dans la liste à puces ou numérotée.
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 3) Pour créer une liste avec les paramètres par défaut, utilisez une des méthodes suivantes :

– cliquez sur l’icône (Dés)activer les puces ( ) ou (Dés)activer la numérotation ( ) 
dans la barre Formatage du texte ou dans la section Listes de l’onglet Propriétés du volet
latéral ;

– sélectionnez Format > Listes > Liste à puces ou Liste numérotée dans la barre de 
menu.

 4) Pour changer le format de la liste en la créant, cliquez sur le petit triangle à droite de l’icône 
et sélectionnez un style parmi les choix offerts par la palette qui s’ouvre alors (Figure 22 et
Figure 23).

Figure 22 : La palette Styles de listes à puces Figure 23 : La palette Styles de listes
numérotées

Ajuster le niveau des entrées d’une liste

Pour ajuster le niveau d’une entrée dans une liste à puces ou numérotée, procédez de la façon 
suivante :

 1) Cliquez au début de l’entrée de la liste. Le curseur doit clignoter au début du paragraphe 
pour pouvoir abaisser ou hausser le niveau de l’élément dans la liste.

 2) Pour abaisser le niveau de l’élément dans la liste, appuyez sur la touche Tabulation. 
Chaque appui va abaisser l’élément d’un niveau supplémentaire.

 3) Pour hausser le niveau de l’élément dans la liste, appuyez sur la combinaison de touches 
Maj+Tabulation. Chaque appui va hausser l’élément d’un niveau supplémentaire.

Éditer et personnaliser une liste

Vous pouvez modifier et personnaliser l’apparence d’une liste en changeant le type de puce ou de 
numérotation de l’ensemble de la liste ou d’une seule entrée ou le niveau de plan d’un élément de 
la liste. Toutes les modifications se font grâce à la boîte de dialogue Puces et numérotation.

 1) Sélectionnez les entrées de la liste que vous souhaitez modifier. La barre d’outils Formatage 
du texte (Figure 1, page 1) s’ouvre automatiquement à la place de la barre d’outils Ligne et 
remplissage.

 2) Pour ouvrir la boîte de dialogue Puces et numérotation (Figure 24), sélectionnez Puces et 
numérotation soit dans le menu Format, soit dans le menu contextuel ouvert par un clic 
droit sur le texte sélectionné.
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 3) Choisissez le niveau que vous souhaitez modifier.

 4) Apportez les changements voulus aux différentes options pour formater le style de chaque 
niveau de la liste. La zone Aperçu vous montre l’aspect de la liste en fonction de vos choix.

 5) Pour annuler les modifications que vous avez faites, cliquez sur Reset (Réinitialiser) pour 
redonner à la liste le formatage qu’elle avait à l’ouverture de la boîte de dialogue.

 6) Quand vous êtes satisfait de vos choix, cliquez sur OK pour enregistrer les changements et 
refermer la boîte de dialogue.

Figure 24 : La boîte de dialogue Puces et numérotation

Options de la boîte de dialogue Puces et numérotation

Les options de la boîte de dialogue Puces et numérotation (Figure 24) sont les suivantes :

Niveau
Choisissez le niveau de plan des entrées dans la liste située à gauche de la boîte de dia-
logue. Chaque niveau peut recevoir un type de liste différent. Le choix 1 – 10 permet de mo-
difier simultanément tous les niveaux de la liste.

Propriétés
Définissez ici l’apparence des entrées dans la liste.

– Type : choisissez le type de marqueur de liste utilisé (Aucun, Puce, Images ou différents 
types de numérotation).

– Couleur : sélectionnez la couleur du marqueur de liste pour qu’il ressorte face au texte de 
l’entrée.

– Commencer à : saisissez la valeur du marqueur de la première entrée de la liste (par 
exemple pour commencer une liste au point 4 au lieu de 1).
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Séparateur
Pour les listes numérotées, vous pouvez définir les caractères qui s’afficheront avant et 
après le numéro de l’entrée dans la liste.

– Avant : saisissez le texte que vous voulez faire apparaître avant le numéro (par exemple, 
Étape).

– Après : saisissez le texte que vous voulez faire apparaître après le numéro (par exemple, 
une parenthèse fermante suivie d’un espace).

Taille
Spécifiez ici la taille du marqueur de liste en pourcentage de la taille des caractères dans le 
paragraphe. Elle peut être plus grande ou plus petite que la taille du texte. Si vous utilisez 
une image comme puce, vous pouvez saisir ses dimensions. L’option Conserver le ratio lie la
largeur et la hauteur de l’image pour en maintenir les proportions : saisissez l’une et l’autre 
est automatiquement calculée.

Position
Cette section vous permet de définir le retrait du paragraphe et l’espacement entre le mar-
queur et le texte de l’entrée de la liste.

– Indentation : saisissez le retrait du marqueur de liste par rapport à la bordure gauche du 
cadre de texte ou de l’objet.

– Largeur : saisissez la distance entre le marqueur de liste et le texte de l’entrée. Cela crée 
visuellement un retrait négatif du marqueur par rapport au texte classique pour les listes à
puces ou numérotées.

– Relatif : si vous cochez cette option, le retrait de l’entrée de la liste est mesuré par rapport
aux réglages du niveau parent quand des styles liés sont utilisés.

– Alignement : sélectionnez l’alignement (gauche, centré ou droite) du marqueur de liste à 
l’intérieur de la zone définie par Largeur. Un alignement à droite vous permet de conser-
ver un alignement correct pour des numéros de listes constitués de deux ou plusieurs 
chiffres.

Portée
– Diapo : les modifications sont appliquées à tous les éléments de votre dessin.

– Sélection : les modifications ne sont appliquées qu’aux éléments sélectionnés de votre 
dessin.

– Appliquer à la diapo maîtresse : les modifications sont appliquées à tous les éléments de 
la page maîtresse de votre dessin, si vous en avez créé une.

Utiliser des tableaux

Les tableaux sont utiles lorsque vous voulez faire figurer des informations structurées dans votre 
dessin, comme une liste de spécifications par exemple. Vous pouvez créer des tableaux directe-
ment dans Draw, sans avoir besoin d’incorporer une feuille de calcul Calc ou un tableau Writer. 
Les tableaux élaborés avec Draw ont cependant des fonctionnalités limitées.
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Créer un tableau

Pour travailler avec des tableaux, il est utile de connaître le nombre de leurs lignes et de leurs co-
lonnes ainsi que leur apparence. Dans un dessin, les tableaux sont placés au centre du dessin, à 
l’intérieur d’un cadre de tableau : ils ne peuvent être placés dans un objet ou une forme. De plus, 
contrairement aux cadres de texte et autres objets, il n’est pas possible de les faire pivoter.

 1) Sélectionnez Insertion > Tableau dans la barre de menu pour ouvrir la boîte de dialogue In-
sérer un tableau (Figure 25).

 2) Choisissez le nombre de lignes et de colonnes de votre tableau.

 3) Cliquez sur OK pour créer un tableau qui sera placé au centre de l’espace de travail, dans 
son cadre.

Figure 25 : La boîte de dialogue
Insérer un tableau

Figure 26 : La palette Tableau

Vous pouvez aussi cliquer sur l’icône Tableau (non visible par défaut) dans la barre d’outils Stan-
dard pour ouvrir la palette Tableau (Figure 26). Cliquez et tirez le pointeur de la souris pour sélec-
tionner les nombres de lignes et de colonnes. Quand vous relâchez le bouton de la souris, le ta-
bleau apparaît au centre de l’espace de travail et la palette se referme. Le bouton Plus d’options 
ouvre la boîte de dialogue Insérer un tableau.

La barre d’outils Tableau

Lorsqu’un tableau est sélectionné, la barre d’outils Tableau (Figure 27) est alors active et offre l’es-
sentiel des outils nécessaires à l’édition des tableaux. Elle apparaît généralement par défaut. Dans
le cas contraire, vous pouvez l’afficher en utilisant Affichage > Barre d’outils > Tableau. Vous 
pouvez également utiliser les outils du menu contextuel.

Normalement, la barre d’outils Tableau est ancrée en haut ou en bas de l’espace de travail. Pour la
transformer en barre d’outils flottante :

• si elle est ancrée en position horizontale, cliquez sur l’extrémité gauche de la barre d’outils et
tirez-la sur l’espace de travail ;

• si elle est ancrée en position verticale, cliquez sur l’extrémité supérieure de la barre d’outils 
et tirez-la sur l’espace de travail.
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Tableau Style de bordure Couleur de bordure

Bordure (Maj pour écraser) Style/couleur de remplissage Fusionner les cellules

Scinder les cellules Optimiser Aligner en haut

Centrer verticalement Aligner en bas Insérer une ligne au-dessus

Insérer une ligne au-dessous Insérer une colonne avant Insérer une colonne après

Supprimer la ligne Supprimer la colonne Sélectionner le tableau

Sélectionner la colonne Sélectionner la ligne Ébauche de tableau

Propriétés du tableau

Figure 27 : La barre d’outils Tableau

Modifier un tableau

Une fois le tableau inséré dans votre dessin, vous pouvez contrôler son apparence, sa taille, sa 
position, etc. en utilisant un ensemble d’outils disponibles dans Draw.

Tableau 
Si vous cliquez sur cette icône, une grille apparaît (Figure 26). Faites glisser le pointeur de la
souris dans cette grille en appuyant sur le bouton pour choisir la dimension du tableau et re-
lâchez le bouton pour créer le tableau. Le bouton Plus d’options ouvre la boîte de dialogue 
Insérer un tableau.

Style de bordure 
Permet de choisir le style de ligne des bordures parmi des styles prédéfinis. Ce
style s’applique aux bordures du tableau ou des cellules sélectionnées. Cliquez
sur l’icône ou le petit triangle à sa droite pour ouvrir une liste déroulante où vous
pourrez choisir parmi les styles prédéfinis.

Couleur de bordure 
Permet de choisir la couleur des lignes des bordures dans la palette de couleurs.
Cette couleur de ligne s’applique aux bordures du tableau ou des cellules sélec-
tionnées. Cliquez sur l’icône pour appliquer la couleur rappelée en bas de celle-ci ou sur le 
petit triangle à sa droite pour ouvrir une palette de couleur où vous pourrez choisir parmi une
gamme de couleurs prédéfinies ou créer la vôtre.

Bordures 
Permet de choisir une configuration de bordure parmi les configurations prédé-
finies. Cette configuration s’applique aux bordures du tableau ou des cellules
sélectionnées. Cliquez sur l’icône ou le petit triangle à sa droite pour ouvrir la
palette présentant les bordures prédéfinies.

Vous pouvez définir plus précisément les bordures en utilisant l’onglet Bor-
dures de la boîte de dialogue Propriétés du tableau.
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Style de remplissage
Permet de choisir le style de remplissage (Aucun(e), Couleur, Dégradé, Hachure, Bitmap, 
Motif) du tableau ou des cellules sélectionnées. La liste déroulante située à droite contient 
des remplissages selon le style choisi.

Fusionner les cellules 
Permet de fusionner les cellules sélectionnées en une seule cellule. Cet outil fusionne égale-
ment le contenu de ces cellules : chaque contenu de cellule forme un nouveau paragraphe. 
Vous pouvez également fusionner des cellules en sélectionnant Fusionner les cellules 
dans le menu contextuel ouvert par un clic droit sur les cellules sélectionnées.

Scinder les cellules 
Assurez-vous que le pointeur de la souris est positionné sur une cellule que vous voulez 
scinder puis cliquez sur l’icône Scinder les cellules pour ouvrir la boîte de dialogue Scinder 
les cellules (Figure 28).

Figure 28 : La boîte de dialogue Scinder les cellules

Choisissez le nombre de cellules à obtenir et le sens du partage (horizontalement ou vertica-
lement). En cas de scission horizontale, vous pouvez cocher En proportions égales pour ob-
tenir des cellules de même taille. Le contenu reste dans les cellules d’origine (celle de 
gauche ou du haut) et n’est pas scindé.

Optimiser
Permet de répartir également les cellules sélectionnées, dans le sens
horizontal ou vertical. Cliquez sur l’icône ou sur le petit triangle à sa
droite pour ouvrir une palette détachable d’outils où vous pourrez faire
votre choix dans une gamme d’options prédéfinies pour optimiser la ré-
partition des cellules sélectionnées.

Aligner en haut  , Centrer verticalement  , Aligner en bas 
Permet d’aligner verticalement le contenu des cellules sélectionnées.

Insérer une ligne au-dessus  , Insérer une ligne au-dessous  , Insérer une colonne 
avant  , Insérer une colonne après 

Permet d’insérer une ligne au-dessus ou au-dessous de la ligne ou une colonne à droite ou à
gauche de la colonne où se trouve le curseur de texte.

Supprimer la ligne  , Supprimer la colonne 
Permet de supprimer la ligne ou la colonne où se trouve le curseur de texte. Vous pouvez 
supprimer plusieurs lignes ou colonnes à la fois en les sélectionnant (totalement ou partielle-
ment) dans le tableau avant de cliquer sur l’icône.
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Sélectionner le tableau  , Sélectionner la colonne  , Sélectionner la ligne 
Permet de sélectionner la totalité du tableau, d’une colonne ou d’une ligne où l’on se trouve 
pour y appliquer les mêmes changements de formatage à toutes les cellules.

Ébauche de tableau 
Permet d’ouvrir la section Ébauche de tableau (Figure 29) dans l’onglet Propriétés du volet 
latéral, où vous pouvez choisir l’apparence du tableau sélectionné.

Figure 29 : La section Ébauche de tableau
dans l’onglet Propriétés du volet latéral

Propriétés du tableau 
Ouvre la boîte de dialogue Propriétés du tableau dont les onglets sont décrits ci-dessous. 
Vous pouvez aussi ouvrir cette boîte de dialogue en sélectionnant Propriétés du tableau 
dans le menu contextuel ouvert par un clic droit sur le tableau.

– Police (identique à la Figure 14 ou à la Figure 15, page 13) : vous pouvez y choisir le type
de police, ses attributs de base (Italique, Gras, Langue, etc.) ainsi que sa taille. Un 
exemple de la police est affiché en bas de la boîte de dialogue.

– Effets de caractère (Figure 30) : Vous pouvez appliquer ici des effets spéciaux au texte 
(sections Couleur de la police, Décoration du texte et Effets).

– Bordures (Figure 31) permet de définir plus précisément les bordures du tableau.

Dans la section Disposition des lignes, vous pouvez choisir une disposition des lignes 
par défaut ou cliquer dans l’aperçu pour définir votre propre style de bordure. Cliquez suc-
cessivement sur une ligne pour ajouter une bordure (apparence du trait), conserver la bor-
dure existante (trait en grisé) ou supprimer une bordure (vide).

Dans la section Ligne, vous pouvez choisir le style, la largeur et la couleur de la ligne de 
bordure.

Dans la section Remplissage, vous pouvez indiquer l’espace que vous voulez laisser 
entre la bordure d’une cellule et son contenu. L’option Synchroniser permet d’appliquer le 
même espacement des quatre côtés de la cellule.
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Figure 30 : L’onglet Effets de caractère de la boîte de dialogue Propriétés du tableau

Figure 31 : L’onglet Bordures de la boîte de dialogue Propriétés du tableau

– Arrière-plan (Figure 32) : cet onglet permet de modifier le fond des cellules sélectionnées ;
il est identique à l’onglet Remplissage de la boîte de dialogue Remplissage (voir le cha-
pitre 4, Modifier les attributs d’un objet, pour plus d’informations).
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Figure 32 : L’onglet Arrière-plan de la boîte de dialogue Propriétés du tableau

– Réinitialiser : cliquez sur ce bouton pour rétablir les options que la boîte de dialogue Pro-
priétés du tableau avait à son ouverture.

Position et taille

Vous pouvez modifier la position du tableau en cliquant et faisant glisser son cadre (voir « Dépla-
cer un cadre de texte », page 4). Vous pouvez modifier sa taille en cliquant et faisant glisser une 
de ses poignées de sélection (voir « Redimensionner un cadre de texte », page 5). Pour un tra-
vail plus précis, vous pouvez sélectionner Format > Position et taille dans la barre de menu, faire
un clic droit et choisir Position et taille dans le menu contextuel, ou appuyer sur la touche F4 pour
ouvrir la boîte de dialogue Position et taille. Vous pouvez aussi utiliser la section Position et taille 
de l’onglet Propriétés du volet latéral. Cependant, vous ne pouvez pas faire effectuer une rotation 
à un tableau.

Supprimer un tableau

Supprimer le tableau entier

Assurez-vous que tout le tableau est sélectionné et que les poignées de sélection sont visibles 
puis supprimez tout le tableau d’une des façons suivantes :

• cliquez sur l’icône Supprimer la ligne   ou Supprimer la colonne   dans la barre d’ou-
tils Tableau (Figure 27, page 27) ;

• faites un clic droit dans le tableau et sélectionnez Supprimer > Supprimer la ligne ou Sup-
primer la colonne dans le menu contextuel.
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Supprimer des lignes ou des colonnes

Sélectionnez les lignes ou les colonnes à supprimer puis procédez d’une des façons suivantes :

• cliquez sur l’icône appropriée, Supprimer la ligne   ou Supprimer la colonne  , dans la
barre d’outils Tableau (Figure 27, page 27) ;

• faites un clic droit dans le tableau et sélectionnez Supprimer > Supprimer la ligne ou Sup-
primer la colonne selon le cas dans le menu contextuel.

Supprimer le contenu des cellules

Pour supprimer le contenu de cellules d’un tableau, procédez comme ceci :

 1) Sélectionnez le contenu des cellules.

 2) Appuyez sur la touche Suppr ou Retour arrière.

Utiliser des champs

Les champs permettent l’insertion automatique de texte dans un dessin. Vous pouvez voir un 
champ comme une sorte de formule dont la valeur est calculée lorsque le document est chargé ou 
imprimé et dont le résultat s’inscrit dans le dessin.

Insérer un champ

Quand vous insérez un champ, un cadre de texte est créé que vous pouvez repositionner comme 
tout autre cadre de texte. Voyez « Déplacer un cadre de texte », page 4, pour plus d’informa-
tions.

Pour insérer un champ dans le dessin, sélectionnez Insertion > Champs dans la barre de menu, 
puis choisissez le champ que vous désirez dans le menu déroulant. Un cadre de texte contenant le
champ est créé au milieu de l’espace de travail.

Vous pouvez également positionner le curseur de texte où vous le souhaitez dans un cadre de 
texte, puis utiliser Insertion > Champs. Le champ sera alors inséré à cet endroit.

Les champs disponibles dans Draw sont :

• Date (fixe) : insère un champ contenant la date au moment de l’insertion du champ.

• Date (variable) : insère un champ qui se met à jour avec la date lors de l’ouverture du docu-
ment.

• Heure (fixe) : insère un champ contenant l’heure au moment de l’insertion du champ.

• Heure (variable) : insère un champ qui se met à jour avec l’heure lors de l’ouverture du docu-
ment.

• Auteur : insère un champ contenant l’auteur du document. Cette information provient de Ou-
tils > Options > LibreOffice > Données d’identité.

• Numéro de page : insère un champ contenant le numéro de la page en cours.

• Titre de la page : insère un champ contenant le nom de la page. Sélectionnez Page > Re-
nommer pour changer le nom par défaut.
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• Nombre de pages : insère un champ contenant le nombre total de pages (diapositives) du 
document.

• Nom de fichier : insère un champ contenant le nom du document.

Personnaliser un champ

Vous pouvez personnaliser le contenu d’un champ, sauf les champs Numéro de page, Nombre de 
page et Titre de la page. Procédez de la façon suivante :

 1) Placez le curseur de texte au début de ce champ et sélectionnez Édition > Champs dans la 
barre de menu. La boîte de dialogue Éditer le champ s’ouvre (Figure 33).

Figure 33 : La boîte de dialogue Éditer le champ

 2) Choisissez un format dans la liste déroulante. Les formats disponibles dépendent du champ 
sélectionné.

 3) Cliquez sur OK pour enregistrer les modifications et refermer la boîte de dialogue.

Vous pouvez également personnaliser un champ en faisant un clic droit sur le champ en mode 
d’édition de texte : le contenu du menu contextuel est équivalent à celui de la boîte de dialogue 
Éditer le champ.

Utiliser des hyperliens

Quand vous insérez un texte qui peut servir d’hyperlien (par exemple, l’adresse ou l’URL d’un site 
web), Draw le formate automatiquement, en créant l’hyperlien, en lui appliquant une couleur et en 
le soulignant.

Insérer des hyperliens

 1) Si vous souhaitez insérer l’hyperlien dans un cadre de texte, cliquez dans celui-ci à l’endroit 
où vous voulez insérer l’hyperlien, sinon veillez à ce qu’aucun objet ne soit sélectionné (l’hy-
perlien sera inséré dans un nouveau cadre de texte situé au centre de l’espace de travail).

 2) Sélectionnez Insertion > Hyperlien dans la barre de menu ou utilisez le raccourci Ctrl+K 
pour ouvrir la boîte de dialogue Hyperlien (Figure 34).

 3) Sélectionnez le type d’hyperlien que vous voulez insérer et les options que vous souhaitez 
utiliser.
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 4) Cliquez sur Appliquer pour insérer l’hyperlien et enregistrer votre sélection. Si vous créez 
plusieurs hyperliens successivement, cliquez sur Appliquer entre chacun d’eux.

 5) Cliquez sur Fermer ou sur OK pour enregistrer vos modifications et refermer la boîte de dia-
logue Hyperlien.

Figure 34 : La boîte de dialogue Hyperlien

Du côté gauche de la boîte de dialogue, choisissez l’un des quatre types d’hyperliens. Le contenu 
de la boîte de dialogue change en fonction de votre choix.

Internet
Choisissez entre un lien Web ou FTP puis saisissez son adresse (URL).

Courrier
Saisissez l’adresse du destinataire et le sujet du courriel.

Document
Vous allez créer un hyperlien vers un autre document ou un autre emplacement dans le des-
sin, ce que l’on appelle couramment un signet.

– Saisissez le chemin vers le document ou cliquez sur l’icône Ouvrir le fichier  pour 
faire apparaître une boîte de dialogue d’ouverture de fichier. Laissez le champ vide si 
vous voulez créer un lien vers une cible dans le même dessin.

– Vous pouvez aussi spécifier une cible (par exemple une page particulière). Cliquez sur 
l’icône Cible dans le document  pour ouvrir la boîte de dialogue de même nom où 
vous pourrez faire votre choix. Si vous connaissez le nom de la cible, vous pouvez le sai-
sir directement dans le champ Cible.

Nouveau document
Vous allez créer un hyperlien qui ouvrira un nouveau document.

– Cochez Éditer maintenant pour modifier immédiatement le document nouvellement créé 
ou Éditer ultérieurement pour le modifier plus tard.

– Choisissez le type de document à créer (texte, classeur, etc.).

– Cliquez sur l’icône Sélectionner un chemin  pour choisir le dossier où sera créé le 
nouveau document.
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Conseil

Pour que LibreOffice ne transforme pas automatiquement les adresses de sites web (URL) 
en hyperliens, ouvrez la page Options de la boîte de dialogue Autocorrection (Outils > Op-
tions d’AutoCorrection) et décochez l’option Détecter les URL.

Pour modifier la couleur des hyperliens, ouvrez la page LibreOffice – Couleurs de l’interface 
dans la boîte de dialogue Options (Outils > Options), recherchez Liens non visités ou Liens
visités dans la section Couleurs personnalisées, cochez ces options et choisissez les nou-
velles couleurs puis cliquez sur OK.

! Attention

Le changement de couleur des hyperliens s’appliquera à tous les modules de LibreOffice, ce
qui n’était peut-être pas votre intention.

La section Paramétrages supplémentaires de la boîte de dialogue Hyperlien est commune à 
tous les types d’hyperliens, bien que certains choix concernent plus certains types que d’autres.

Cadre
Le choix dans la liste déroulante détermine comment l’hyperlien s’ouvre. Il s’applique aux do-
cuments qui s’ouvrent dans un navigateur web.

Formulaire
Le choix fait ici détermine si le lien est affiché sous forme de texte ou de bouton.

Texte
Saisissez ici le texte qui sera visible dans votre dessin.

Nom
Saisissez le texte qui sera ajouté comme attribut NAME dans le code HTML derrière l’hyper-
lien. Ne s’applique qu’au document HTML.

Éditer les hyperliens

 1) Sélectionnez l’hyperlien.

 2) Choisissez Édition > Hyperlien dans la barre de menu pour ouvrir la boîte de dialogue Hy-
perlien (Figure 34, page 34).

 3) Apportez les modifications souhaitées aux différentes options puis cliquez sur Appliquer 
quand vous avez fini. Si vous devez modifier plusieurs hyperliens, cliquez sur Appliquer 
après chacun d’eux.

 4) Cliquez sur Fermer ou sur OK pour enregistrer vos modifications et refermer la boîte de dia-
logue.

Images cliquables

Une image cliquable définit des zones (appelées zones sensibles) reliées par un hyperlien à une 
adresse web, d’autres fichiers sur l’ordinateur ou d’autres parties du même document. Les zones 
sensibles sont l’équivalent graphique des hyperliens textuels. Quand on clique sur une zone sen-
sible, LibreOffice ouvre la page liée dans le programme associé (par exemple, le navigateur par 
défaut pour les pages HTML, LibreOffice Calc pour un fichier ODS, un lecteur de PDF pour les fi-
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chiers PDF). Vous pouvez créer des zones sensibles de diverses formes et inclure plusieurs zones
sensibles dans la même image.

Pour utiliser l’éditeur d’image cliquable (Figure 35) :

 1) Sélectionnez une image de votre document Draw dans laquelle vous voulez créer une zone 
sensible.

 2) Choisissez Outils > Image Map dans la barre de menu pour ouvrir l’éditeur d’image cli-
quable.

 3) Sélectionnez le type de zone sensible que vous voulez créer parmi les icônes en haut de 
l’éditeur d’image cliquable : rectangle , ellipse , polygone , polygone à main levée 

 4) Dessinez la zone sensible sur l’image.

 5) Saisissez l’adresse pointée par l’hyperlien dans le champ Adresse en utilisant le format 
d’adresse file:///<chemin>/nom_du_document#nom_de_l’ancre.

 6) Cliquez sur l’icône Appliquer  pour appliquer ces réglages.

 7) Quand vous avez fini, cliquez sur l’icône Enregistrer  pour sauvegarder l’image cliquable 
dans un fichier puis refermez l’éditeur.

Figure 35 : L’éditeur d’image cliquable

La plus grande partie de l’éditeur d’image cliquable affiche l’image sur laquelle les zones sensibles
sont définies. Ceux-ci sont indiqués par un contour de la forme utilisée pour les créer.
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L’éditeur d’image cliquable propose les outils suivants :

• Appliquer  : applique les modifications.

• Ouvrir , Enregistrer , Sélectionner .

• Formes des zones sensibles : Rectangle , Ellipse , Polygone , Polygone à main 
levée .

• Éditer les points , Déplacer des points , Insérer des points  et Supprimer des 
points  : outils d’édition détaillée pour manipuler la forme d’une zone sensible polygonale.
Sélectionnez Éditer les points pour activer les autres.

• Défaire  et Refaire .

• Actif  : alterne l’état de la zone sensible sélectionnée entre actif et inactif.

• Macro  : associe une macro à la zone sensible au lieu de simplement lui associer un hy-
perlien.

• Propriétés  : définit les propriétés de l’hyperlien et lui ajoute l’attribut Name.

• Adresse : saisissez ici l’adresse pointée par l’hyperlien. Vous pouvez aussi pointer vers une 
ancre dans un document.

• Texte : saisissez ici le texte que vous voulez voir affiché quand le pointeur de la souris sur-
vole la zone sensible.

• Cadre définit l’endroit où la cible de l’hyperlien va s’ouvrir (_self ouvre la cible dans la fenêtre
active du navigateur).

Fontwork

Avec Fontwork vous pouvez créer des objets graphiques de texte artistique qui rendront votre tra-
vail plus attrayant. Ils offrent un grand choix de paramètres différents (ligne, remplissage, position, 
taille, etc.).

Fontwork est aussi disponible avec les modules Writer, Calc et Impress, mais vous noterez de pe-
tites différences dans la façon dont chacun l’affiche.

Créer un objet de Fontwork

 1) Cliquez sur l’icône Fontwork  dans la barre d’outils Dessin ou la barre d’outils Standard, 
ou sélectionnez Insertion > Fontwork dans la barre de menu pour ouvrir la boîte de dia-
logue Galerie Fontwork (Figure 36).

 2) Sélectionnez un style dans la Galerie Fontwork et cliquez sur OK. L’objet apparaît dans votre
dessin et la boîte de dialogue se referme.

 3) Faites un double-clic sur le mot Fontwork pour passer en mode édition.
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Figure 36 : La galerie Fontwork

 4) Tapez le texte qui doit remplacer le mot Fontwork ; il apparaît en noir au-dessus de celui-ci 
comme sur la Figure 37.

Figure 37 : Éditer le texte d’un objet de Fontwork

 5) Appuyez sur la touche Échap ou cliquez hors du rectangle de sélection et votre texte prend 
la place du mot Fontwork.
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Figure 38 : Objet Fontwork après édition du texte

La barre d’outils Fontwork

La barre d’outils Fontwork (Figure 39) apparaît dans l’espace de travail quand vous sélectionnez 
un objet Fontwork. Si ce n’est pas le cas, sélectionnez Affichage > Barres d’outils > Fontwork 
dans la barre de menu.

Style Fontwork Forme Fontwork
Hauteur identique pour les 
lettres Fontwork

Alignement Fontwork
Espacement des carac-
tères Fontwork

(Dés)activer l’extrusion

Figure 39 : La barre d’outils Fontwork

La barre d’outils Fontwork offre les outils suivants :

Style Fontwork 
Ouvre la boîte de dialogue Galerie Fontwork (Figure 36).

Forme Fontwork 
Ouvre la palette Forme Fontwork, transformable en barre d’outils (Figure 40) où vous pouvez
changer la forme de l’objet sélectionné.

Figure 40 : La barre d’outils Forme Fontwork

Hauteur identique pour les lettres Fontwork 
Alterne entre une hauteur normale, où les caractères ont des hauteurs différentes, et une 
hauteur identique pour tous les caractères du texte.

Alignement Fontwork 
Spécifie l’alignement du texte à l’intérieur du cadre. Les choix possibles sont Aligner à 
gauche, Centrer, Aligner à droite, Mots justifiés et Étirement justifié. Les effets ne sont vi-
sibles que si le texte est réparti sur deux lignes ou plus. Dans le mode Étirement justifié, 
toutes les lignes sont entièrement remplies.
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Espacement des caractères Fontwork 
Choisissez l’espacement entre les caractères et si les paires de crénage doivent être utili-
sées. Les options proposées sont Très serré, Serré, Normal, Large, Très large et Personnali-
sé. Pour l’espacement personnalisé, saisissez une valeur en pourcentage : 100 % corres-
pond à l’espacement normal, moins de 100 % pour des caractères plus serrés et plus de 
100 % pour des caractères plus espacés.

(Dés)activer l’extrusion 
Cette icône permet de convertir l’objet Fontwork en une séquence 3D par extrusion. Voir le 
chapitre 7, Manipuler les objets 3D, pour plus d’informations.

Modifier les objets Fontwork

Un objet Fontwork peut être traité comme tout autre objet dans Draw : ses dimensions peuvent 
être modifiés, il peut être pivoté, déformé, incliné, retourné, etc. Pour plus d’informations sur la mo-
dification d’un objet Fontwork, voyez le chapitre 3, Manipuler les objets et les points des objets, le 
chapitre 4, Modifier les attributs d'un objet, et le chapitre 5, Combiner plusieurs objets.

Il est possible de traiter un texte Fontwork comme un objet et de lui appliquer tous les formatages 
qui ont été décrits dans ce chapitre. N’affectez des propriétés de ligne qu’aux objets Fontwork qui 
n’ont pas d’effet 3D, sinon les changements ne seront pas visibles.

Il est possible de modifier certaines formes de Fontwork comme on modifie les angles des formes 
de base trapèze et parallélogramme en déplaçant le point qui s’affiche avec les poignées de sélec-
tion.
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